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INTRODUCTION

QwikChord is the 3rd major release of this applica�on, and incorporates many features that have been requested

by users over the years. QwikChord (originally named QuickChord) was ini�ally released in 2003 as a freeware

applica�on.

The concept was simple: do one thing, and do it well. At a �me when guitar players and instructors were faced

with a mul�tude of applica�ons that tried to do everything, QwikChord did one thing: make chord diagrams.

QwikChord became an underground sensa�on among guitar teachers worldwide, sparked by a guitar magazine in

the UK including the program as a free giveaway by including it on the CD that shipped with the magazine in 2005.

Over the course of the next 6 years, QwikChord has been downloaded over a million �mes.

QUICK START

When QwikChord is opened, you will be presented with the main screen as shown in Figure 1, below.

Figure 1

By default, we are looking at a 6 string instrument with 5 frets. The top fret of the diagram is indicated by the

number at the top le5. In this case, the top fret is fret 1. This area is referred to as the “Chord Builder.”

MAKING CHORDS

Crea�ng a chord diagram is simple as clicking on the blank diagram to indicate where the strings are to be fre?ed. 

Since this is a chord diagram, it will only allow a single fre?ed note per string, so if you click on another fret on a

string with a note on it, the dot moves to the new loca�on.

You will also no�ce that the X’s at the top of the diagram change. X indicates a string that is not played, so when

you have a fre?ed string, the X is removed. If you wish to indicate that an open string is to be played, simply click

on the X to change it to an O. Here is what the diagram looks like when we set all the strings to play a GMajor

chord:
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Figure 2

Press the “Clear ->” bu?on to clear the chord.

BARRE CHORDS

QwikChord allows you to notate a Barre chord by including a line that indicates that a single finger is holding down

the notes on several strings. Figure 3 below shows a F minor barre chord.

Figure 3

This chord is created by seHng all the frets as you would normally. To create the barre line, click down on the 1st

 string, 1st fret, and drag the mouse to the 6th string, 1st fret. As you drag the mouse, you will see a blue line move

with the mouse. When it is released, the barre line is set in place.

You can have up to two barre lines in each diagram.

If you want to remove the barre lines, simply click on the “No Barre” bu?on.

CHORD NAMES AND NOTE NAMES

You will no�ce as you create diagrams that QwikChord automa�cally puts the note names under each string, and

automa�cally calculates the chord name for you.

QwikChord uses an advanced chord engine to determine the chord names of the finger diagrams. This is done by

taking the tuning of the instrument (as indicated by the Tuning bu?on above the diagram), and using the Top Fret

as a star�ng point. With those two items of informa�on, it is easy to determine the notes in the diagram.

These notes are then compared to know chord forms, and the closest matching chord name is determined.

MOVING THE TOP FRET

Let’s leave the F minor chord on the diagram, and move the top fret to see what happens. Use the blue arrow keys

to the le5 of the diagram to change the top fret number. No�ces that the notes and chord name adjust to show
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the correct informa�on based on the top fret you selected. Here is our barre chord shi5ed so the top fret is the

3rd fret of the guitar instead of the 1st fret:

Figure 4

OVERRIDING CHORD NAMES

Some�mes it is necessary to override the automa�cally calculated features in QwikChord. There are o5en several

different representa�ons for a single chord structure, and the type of music a guitarist plays --and where they

live-- o5en influence the preferences of what is expected on a chord diagram.

Fortunately, this is very easy to change!

To use your own chord name, simply click on the chord name (or the blank area where the chord name would

normally appear) and the following dialog will appear:

Figure 5

You will no�ce that the “Use Automa�c Names” box at the bo?om is checked, indica�ng that this chord is

currently set to automa�cally calculate the chord name. To override this, simply type in the name you would like

to use.

NOTE: The “Use Automa�c Names” checkbox becomes UN-checked when you enter a name! This means that the

chord will no longer try to automa�cally create a chord name, and will use the name you entered instead.

Click the Done bu?on to see the results. A5er you override the chord name, you will no�ce that your manually

entered name remains the chord name, even when you change the fingering. It will stay this way un�l you hit the

“Clear ->” bu?on, which resets the current chord back to the the defaults.

You can also select a different Root Note, and change the color of the Root Note dots. It is important to remember

that if you do override the root note, the “Use Automa�c Names” op�on becomes UN-checked.

OVERRIDING NOTE NAMES

Just as you can enter your own chord names, you can also enter custom text to appear under each string. Some

users prefer to see interval nota�on (guitarists that use the Nashville no�on prefer this style), and some users

prefer to use numbers to indicate which fingers are used to fret each note.

This is easy to do in QwikChord! Just click on the notes below the strings (the the blank area where they will

normally appear), and you will see the following dialog open:
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Figure 6

Simply change the text under each string to what you would prefer to see.

NOTE: The “Use Automa�c Names” checkbox becomes UN-checked when you change any text! This means that

QwikChord will no longer try to automa�cally create the string text, and will use the text you entered instead.

Click the Done bu?on to see the results. A5er you override the string text, you will no�ce that your manually

entered text remains even when you change the fingering. It will stay this way un�l you hit the “Clear ->” bu?on,

which resets the current chord back to the defaults.

ADVANCED CHORD DECORATIONS

For users who wish to create diagrams in the style of jazz legend Ted Greene’s work, or who are using QwikChord

to create scale charts, the “Decora�ons Toolbox” contains a large number of symbols that can be added to the

chord diagram.

Click the “Show Toolbox” bu?on view the Decora�on Toolbox, as shown below:

Figure 7

The currently selected decora�on is indicated by a red outline, and when you first open the toolbox you will see

that the standard large filled circle is selected.

Simply click on a different decora�on to select it.

You can change the color of the decora�on by clicking the “Decora�on Color” bu?on below the toolbox.

NOTE: The color you select will become the default color for the decora�on you selected! For example, if you select

the X decora�on and make it red, that will become the default color when you select the X.

 Decora�ons are “stackable,” which means that you can put more than one decora�on on a fret at a �me. The

example below shows typical chord diagrams where the Note Name or fingering is shown inside of the fret dots:
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Figure 8

Of course, you can make them as bizarre as you want to by stacking mul�ple decora�ons and colors:

Figure 9

USING DECORATIONS

Decora�ons in the same “family” (the decora�ons in the same row: Filled, Outline, 50% Outlined) will replace

each other. So if you have a large filled square on a fret, and decide that you want to put an outlined square there

instead, the outline will REPLACE the filled square instead of being stacked on top of it.

Just as before, decora�ons toggle visibility when you click them. If you are have the standard large filled circle

selected, clicking and empty fret will display a dot. Clicking it again will remove the dot. When you have a stack of

decora�ons, only the selected decora�on will change in the stack: all the other decora�ons will remain

unchanged.

USING TEXT DECORATIONS

The Text decora�on (shown as an A#) symbol in the toolbox, operates a li?le differently than the other

decora�ons.

The first (and arguably most important) difference is that Text items are always on the top of the stack. If you have

a Text item on a fret and then select a different decora�on and click on the fret, that decora�on will be placed

beneath the text.

The second difference is that there are two ways to put text on the fret board.

1. Select the Text (A#) decora�on and click on the diagram. The text tool will automa�cally assume you are

pain�ng “Note names” and insert the correct note where you clicked.

2. If you Right-Click on a fret, you will get a dialog box that allows you to enter whatever text you want to

appear.

NOTE: This can be done at any �me, and with any other decora�on selected. It will also work if the

Decora�on Toolbox is not visible.

Normally, most users will set the text decora�on to be white in color, and place text on top of a large filled

decora�on.
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COPYING CHORD DIAGRAMS

OK, so now that you have a chord diagram, what can you do with it? The easiest thing to do is to paste a diagram

into another document. With a chord diagram displayed, simply hit <Ctrl><C> (Or, Edit -> Copy Image To

Clipboard from the menu) to copy the chord diagram, then switch to another applica�on (for instance, Microso5

Word) and hit <Ctrl><V> to paste it.

Almost too easy, isn’t it?

There are some cross-plaTorm applica�ons (OpenOffice, for example) that do not paste graphics correctly from

QwikChord, due to changes in Microso5’s architecture. (The OpenOffice team currently lists this as an open issue,

and is working on it.)  Fortunately, it is very easy to set QwikChord to save your diagrams to a “Clip-Art” or “Theme

Gallery” folder for that applica�on, and you can just drag and drop diagrams from there!
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SETTING OPTIONS

There are several op�ons you can change to customize how QwikChord operates. Clicking the “Op�ons” bu?on

will open the following dialog in QwikChord:

Figure 10

This window allows you to change the “global parameters” of how QwikChord works, and contains a preview

window to allow you to see how your changes will look.

NOTE: The current chord in the Chord Builder will be cleared when you open the Op�ons dialog! Be sure to save it

to the Favorites area if you want to con�nue working with a chord.

The table below explains the op�ons available:

Note Selec�on Preference Notes can either be sharp or flat. For instance the note between A and B

can be called either A sharp or B flat. When calcula�ng a chord name,

QwikChord need to know which you prefer to see.

Sharp Symbol You can chose the symbol used to indicate sharp notes. It can be either: #

or +. The # is the default.

Flat Symbol You can chose the symbol used to indicate flat notes. It can be either: b or

-. The b is the default.

NOTE: A lowercase b is used instead of the true flat symbol as many users

do not have the appropriate fonts to display the correct character.

# of Strings You can have between 4 and 7 strings in your chord diagram. The default is

6 strings for a guitar.

# of Frets You can have between 5 and 10 frets for a diagram. Most chord diagrams

show 5 frets, however higher numbers are useful for scales.

NOTE: Although the Chord Builder display “squashes” the diagram to fit in

the editor, the saved or copied graphic files are the correct aspect ra�o.
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Fret Numbers You can show the fret number only at the Top Fret (default), on All Frets,

or not show them at all. Also, you may chose to use roman numerals for

the fret numbers.

Diagram Type There are two choices: Chord or Scale. A chord diagram limits you to a

single note per string. A Scale diagram allows to have as many fre?ed

notes per string as you want, however the chord name and notes will NOT

be calculated and ALWAYS need to be manually entered in this mode.

Calculate Chord Name If set, QwikChord will automa�cally calculate the chord name. This op�on

is only available in Chord Diagram mode.

Show Notes Under Chord If set, QwikChord will automa�cally calculate the note name for each

string. This op�on is only available in Chord Diagram mode.

Clipboard Size This indicates the width of the graphic that is created when you copy and

paste a chord diagram from QwikChord.

Root Note Color This bu?on sets the color of the root note dots on the chord diagram. By

default, the root note color is Black, the same as the other notes. If you

want the root notes of the chord to be highlighted in a different color, click

the bu?on to select a new color.  For example:

Font Name You can use any font for the text in your diagrams. Be aware that some

fonts installed by other applica�ons may not display the way you expect

them to.

Font Smoothing This determine how text smoothing is applied to a diagram. ClearType

GridFit is the default, and looks great in most applica�ons. However, if you

are trying to create �ny graphic files, you may want to try different

smoothing to make the characters more legible.

Chord Alignment Chord names can be aligned Le5 / Center / Right.

Barre Line You can select a curved or straight line to indicate a Barre.

QwikChord default is a curved Barre line.

SETTING TUNING

Guitar players love different tunings! Fortunately, QwikChord is a general purpose chord diagram generator and is

perfectly at home crea�ng diagrams for other instruments as well. Click the Tuning bu?on above the chord

diagram to set the tuning you want to use. The following dialog will be displayed:

Figure 11
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The top of the dialog shows the tuning name, and a row of boxes that indicate what each string is tuned to. To

adjust the tuning for each string, simply click on the box for that string (it will highlight in green to indicate that it

is selected), and use the slider to the right (or the Up/Down arrows on your keyboard) to adjust the tuning.

SAVING TUNINGS TO FAVORITES

If you would like to save the tuning for future use, make sure it has a descrip�ve name and click on the arrow that

is poin�ng into the “Saved Tunings” area. It will be added to the list, and will always be available for future use.

RESTORING SAVED TUNINGS

When you click on a name in the Save Tuning area, you will no�ce that the arrow to the le5 changes to point to

the top. Just click on the arrow, and your selected tuning will be moved to the current tuning area at the top.

DELETING TUNINGS

When a tuning name is selected in the Saved Tunings area, you will no�ce that the garbage can is visible to the

le5. If you wish to delete the tuning, just click the garbage can. You will be prompted before the tuning is deleted.

COMMITTING CHANGES

The Exit bu?on closes the Tuning page. If you have made changes to the current tuning, you will be asked if you

want to use that tuning. Clicking Yes will make that the new default tuning for your chords.

Clicking No will ignore any changes you made, and let you con�nue using the tuning as it was prior to visi�ng the

Tuning page.

SAVING /RESTORING FAVORITES

Back on the main page, let’s look at how you can work with several chords using the Favorites area. You can think

of the favorites area as a temporary storage area for you to work with a collec�on of chords that you intend to

save or send to others.

When you are crea�ng a chord diagram in the chord builder, you will no�ce the arrow poin�ng to the Favorites

area directly below. Clicking this arrow will add the current chord to the list of favorites. You can add as many

chords as you like to this list.

When you click on a chord name in the Favorites, you will no�ce two things: the arrow will change to point back

to the Chord Builder, and the garbage can will appear, as shown below:
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Figure 12

Clicking the arrow (or double-clicking a chord name) will restore the favorite chord to the Chord Builder area,

where you can resume changing it, or copy it to another applica�on.

Clicking the garbage can will remove the chord from the Favorites list. You can also select mul�ple chord names

and delete them all at the same �me.

SAVING FILES

Once you have several chords in the Favorites list, it is easy to save them. You will no�ce the Save… bu?on is

visible whenever you select a chord in the Favorites list. Clicking this bu?on will open the Save Files dialog shown

here:

Figure 13

The Save Files dialog is designed to save ALL the files in the Favorites list. You can save them as na�ve QwikChord

(QC3) files, as graphics (JPG, BMP, and PNG are supported), or both.

Click the Browse bu?on to select the folder to save the files to. This folder name will show in the box �tled

“Folder to save files to.”

Next, decide what kind of files you want to save by puHng a checkmark in the “Save QwikChord QC3 files” and

“Save Graphic Images” boxes.

If you selected to save your files as graphic files, another set of op�ons will become visible to you:

- Graphic Format

o You can choose either JPG, BMP, or PNG graphics

- Graphic Size

o Default Width: 88

o Tiny Width: 50 (Good when there is no chord names or string text)

o Custom Width

If you select a custom size, you will be able to specify  a width to use for the graphic file. The height is
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automa�cally calculated by QwikChord so the resul�ng diagram has the correct aspect ra�o.

NOTE: The minimum width that can be created is 50 pixels, anything smaller will not be allowed.

Once you have selected you save op�ons, click the Save bu?on. All the chords in your favorites list will be

processed and the folder you selected will contain the files.

OPENING FILES

When you install QwikChord, it will automa�cally be associated with QC3 files. If you double-click a QC3 file in

explorer, or a?empt to open one via email or the web, it will open in QwikChord automa�cally.

You can also open several QC3 files at the same �me, and load them all into your favorites list. Select File -> Open

To Favorites from the menu in QwikChord,  from here you can select several QC3 files at the same �me and they

will all open in the Favorites area.

CHORD DEFINITION EDITOR

QwikChord is pre-configured with a set of “shorthand” nota�on for all the chord names, which are normally fine

for most scenarios. However, depending on the instrument (QwikChord is used for more than just guitars!),

audience, or type of music, there are �mes when users prefer to see a different way of expressing a chord name.

While you can overwrite the chord name with custom text at any �me, if you constantly need to edit a specific

chord name because the default “shorthand” is not suitable, it is �me to use the Chord Defini�on Editor.

Let’s say we have a Gadd2 chord, as shown here:

Figure 14

If I prefer to always see “add2” chords show up as “add9” chords (technically, they contain the same notes, the

voicing is different), then we need to re-define the shorthand for this par�cular chord pa?ern.

From the edit menu, select Edit -> Chord Defini8on Editor… to see this dialog:
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Figure 15

If you already have a chord in the Chord Builder (in this example, we had Gadd2 displayed), then the Chord

Defini�on Editor will highlight the current chord name as shown above.

The list at the top is every chord name that QwikChord recognizes. If you click a chord name, directly below the

list you will see the Long Name, the Shorthand, and a Sample of what a chord name would look like with the

Shorthand name applied.

When we change the shorthand from add2 to add9, and Save / Cancel pair of bu?ons will appear to allow you to

save your changes. You can con�nue to change as many chord defini�ons as you wish.

When you are done edi�ng, you have two op�ons:

Save Changes: This will permanently save all the changes you made while in the Chord Defini�on Editor. From this

�me forward, any chords you create in the Chord Builder will use the shorthand names you have edited.

Discard and Exit: This op�on exits the Chord Defini�on Editor without saving any changes you made. All edits you

have made will be lost.

Finally, there is the Restore All Defaults bu?on.

This overwrites ALL shorthand nota�on back to the “out of the box” defaults. You will be given a prompt asking

you to confirm that you want to do this, and just like individual edits, you will need to click the “Save Changes”

bu?on to permanently save the changes.

GETTING UPDATES

We have always been, and always will be, a customer oriented company. As so5ware developers we understand

the current trend to use key generators and online registra�on to prevent people from copying so5ware, however

as an end user nothing is more aggrava�ng than trying to install a piece of so5ware you’ve installed on another

computer only to find out you are prevented from doing so.

We believe that when you pay for so5ware, it is yours to do with what you want to.

If you want to install it on a single computer, or a dozen, it is totally up to you. We use no online registra�on or

codes to limit or track your installa�on, and when you receive the installer it is a fully func�onal applica�on that

does not install any 3rd party applica�ons or track your usage.

We believe that a certain amount of copying so5ware for friends is good for a company: it exposes more people to

our so5ware than we could have reached, and hopefully they will see fit to buy their own copy one day.
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We handle updates differently than most companies. When you buy QwikChord, you are en�tled to free

maintenance updates for the life of the product. We distribute these updates ONLY via email to those people that

have purchased the product.

This way, we hope to put piracy control back in the hands of the consumer. You are free to copy and distribute

your so5ware as much as you want to, however, only you will be receiving updates. While you can certainly spend

your days sending your updates out to everyone you copied the program to, we assume that will get old a5er a

while.

Click on the Help -> Check For Updates item in the QwikChord menu, and QwikChord will anonymously request

the latest revision number of QwikChord. If there is a new version available, all you need to do is click the link and

request that QwikChord.com send you the latest release.

Simple!

SUPPORT

QwikChord has been the result of community effort, and we offer sincere and deep thanks to the thousands of

users that have taken the �me over the years to write in with sugges�ons and feedback.

If you have any requests or comments, please visit our website at www.QwikChord.com and take a moment to let

us know! We s�ll take the �me to personally reply to almost every email we receive, and our customers recognize

the value in seeing their ideas are heard as we incorporate their sugges�ons into the product.

Thank you!
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